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Overview
Introduction
The new Apogee Ensemble is the first Thunderbolt™ 2 audio interface to offer superior sound quality, the 
lowest latency performance and the most comprehensive studio functionality all in one box. Ensemble includes 
8 Advanced Stepped Gain mic preamps, monitor controller functionality including talkback, front panel Guitar 
I/O, two headphone outputs and digital connectivity for a total of 30 x 34 I/O. Blending acclaimed innovations, 
groundbreaking new features and an effortless user interface, Ensemble empowers you to capture inspiration 
when creative lightning strikes.

Now includes the new Control software first introduced with the Element Thunderbolt Series interfaces. Along 
with innovative features such as Talkback using your Mac’s built-in microphone, and the unique FX Return mixer 
channel, Ensemble Thunderbolt can now be combined with any Element Series Thunderbolt Series interface, or 
another Ensemble Thunderbolt for expanded I/O and capabilities.

Features

•  Thunderbolt™ 2 Mac audio interface
•  Analog-to-digital conversion (ADC) for recording up to 24-bit/192kHz

•  Proprietary Thunderbolt audio driver and ESS Sabre32 DAC offer full 32-bit playback
•  Groundbreaking low latency performance

•  Core Audio-optimized hardware DMA Engine frees your Mac CPU
•  2 high-resolution OLED displays show levels and settings
•  Input select buttons and controller knob for convenient selection of parameters and settings
•  4 assignable buttons to control:

•  Talkback mic (built-in or external)
•  Output settings such as speaker set selection, mute, dim, sum to mono

•  Complete input/output control with Apogee’s Maestro software
•  Works with Pro Tools, Logic, Ableton and any Core Audio compliant app on Mac
•  Designed in California – Assembled in the U.S.A.

5



6

Apogee Ensemble Thunderbolt | User’s Guide 

Package Contents
The following items are included in the box with Ensemble:
•  3 pin-IEC power cable
•  QuickStart Guide
•  Rubber Feet
•  Warranty Booklet

  

Register your product
• Access Apogee’s expert Technical Support for free
• Receive important product update information by email

www.apogeedigital.com/register

http://www.apogeedigital.com/register
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5.	 Built-in Mic (see page 32):
a.	 The built-in mic can be recorded, 

or used for the talkback function.
b.	 Is a mono source. The same 

signal is duplicated on channels 
9 and 10.

6.	 Assignable Buttons:
Programmed from the Apogee Control software’s 
Remote & Front Panel Assignments Window (see 
page 51). Factory default settings are:
a.	 Talkback - must hold button 

down to use (momentary).
b.	 Clear Meters.
c.	 Toggle G1/G2 output source 

between “Thru” and “From 
Software”.

d.	 Toggle Mute function between Monitor Out 
and Headphones outputs.

7.	 Headphones 1&2 Controller Knobs:
a.	 Turn to adjust headphone 

output volume.
b.	 Push to toggle mute on/off.

8.	 Power Button:

Ensemble Thunderbolt Panel Tour

Front Panel

1.	 Guitar I/O (see page 25):
a.	 Inputs ch 11/12: Connect high 

impedance (Hi-Z) instruments 
such as guitar or bass. 

b.	 Outputs ch 11/12: Instrument 
level outputs for connecting 
directly to a guitar amplifier or 
Hi-Z pedal effects/processor.

2.	 Input Select Buttons:
a.	 Push to select an input
b.	 Push again to view the 

Input Settings screen

3.	 Input Controller Knob:
a.	 Turn to adjust gain. When 

viewing input settings, turn to 
move to the next parameter.

b.	 Push to select the next input. 
When viewing input settings, 
push to change a parameter’s 
setting.

4.	 Output Controller Knob:
a.	 Turn to adjust the volume of 

your monitor speakers.
b.	 Push to toggle your monitor 

speakers mute On/Off.
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Rear Panel

1.	 Inputs 1-4:
Combination (combi) jacks receive XLR or 1/4” 
connectors
a.	 Use XLR for a microphone or line level input.
b.	 Use 1/4” for high-impedance (Hi-Z) instrument.

2.	 Inputs 5-8:
XLR for microphones or line level inputs.

￼
3.	 Analog Inserts: Channels 1 & 2 (page 31)

a.	 Send (top)  - can use balanced TRS or 
unbalanced TS 1/4” cables.

b.	 Return (bottom) - can use balanced TRS or 
unbalanced TS 1/4” cables.

￼
4.	 Monitor Out:

Balanced TRS outputs for connecting monitor 
speakers.

￼
5.	 Analog Out:￼

Balanced outputs 3-10. 
Requires a 25-pin D-Sub 
analog breakout cable.

6.	 Digital I/O: (page 33)

a.	 Optical (Toslink): Two In/Out Ports
i.	 ADAT, 8-channels per 

port, 44.1-48k sample 
rate.

ii.	 SMUX, 4-channels per port, 88.2-96k 
sample rate.

iii.	 S/PDIF, 2-channels per port, 44.1-96k 
sample rate. 

b.	 Coaxial￼
i.	 Provides 2-channels of audio 

at sample rates of 44.1 - 192k.

7.	 BNC Word Clock:
Used to transmit or receive word 
clock signal between Ensemble and 
other digital devices (page 38).

8.	 Thunderbolt 2:
•	 Two ports for daisy chaining 

up to six devices.
•	 It does not matter which 

position Ensemble is placed 
in the chain.

•	 Backwards compatible with Thunderbolt 1 (see 
Thunderbolt Notes on page 13).
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Display

Input Settings Display Screen

This screen appears when an Input Select button is pressed a second time. The 
parameters available will change depending on the channel being viewed, and the 
settings made. For navigation instructions, see page 17.

1.	 Input Source￼
a.	 Mic - XLR input is sent through the microphone preamp
b.	 Inst - 1/4” input is sent through a Hi-Z to Low-Z circuit then to the microphone preamp
c.	 +4dBu/-10dBV - Line level signal from XLR input bypasses preamp circuit

2.	 Soft Limit - Attenuates transient peaks of the analog input at a threshold of -4dBfs 
before the signal is sent to the A/D converter (see page 61).

3.	 Group - The gain of input channels grouped together are adjusted simultaneously. 
Any level offsets that exists before inputs are grouped will be preserved.

4.	 Insert - Directs signal from the Input 1 or 2 Insert Return jack to the A/D converter 
(Insert Send is always active and can be utilized as a preamp line-out).

5.	 ∅ (Polarity) - Inverts the input signal’s polarity.

6.	 48v - Toggles phantom power on/off.

7.	  ⦧ - Toggles High Pass filter (80Hz, 12dB/octave) on/off.
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Control - Hardware Remote (Optional)
This programmable control surface is used to adjust settings and parameters of your Ensemble Thunderbolt. 
For a full list of programmable features, see the Control Remote Assignments section of the Apogee Control 
Software section on page 51.

To Computer - Micro USB port for connecting to your computer. 
Use a standard USB-A to USB-MICRO-B cable.

Display Indicators - Shows currently selected input, the input type, as well 
as the output selection.

Assignable Buttons - Performs the assigned function. Any function can be 
assigned to any button via the Apogee Control software (page 51).

The factory default assignments are:

Microphone button
- One push focuses the knob on adjusting the input gain level.
- Multiple presses cycles through the input channels.

Headphone button
- One push focuses the knob on adjusting the headphones volume level.
- Multiple presses cycles through the headphone outputs.

Speaker button
- Focuses the knob on adjusting the speaker volume level.
 

Control Knob
- Turn to adjust settings.
- Push down to mute all outputs.
       - The push button can be assigned to another function via the Apogee Control software (page 51).

1 - Clear Meters
2 - Dim Speakers
3 - Toggle Speaker Sets
4 - Toggle Main Source

A - Launch Apogee Control
B - Mono Speakers
C - Set Main Out to Reference
D - Momentary Talkback
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Getting Started
Precautions when powering Ensemble On/Off

Before powering Ensemble On, ensure that any speakers or amplifiers connected to 
Ensemble’s analog outputs are powered off, or the volume turned down to the minimum 
setting. This will prevent potential damage to your speakers and other equipment from “pops” 
that may occur as the unit boots up.

1.	 Power off speakers
2.	 Power Ensemble On
3.	 Power on speakers

Likewise, before powering Ensemble off, ensure any speakers or amplifiers connected to Ensemble’s analog 
outputs are turned off, or the volume turned down to the minimum setting.

1.	 Power off speakers
2.	 Power Ensemble Off

Connect Ensemble to your Computer
Single Unit

Ensemble features two Thunderbolt™ 2 connections to enable daisy-chaining of other Thunderbolt peripherals 
to your computer. Ensemble does not have to be first in the chain, but it is recommended.

1.	 Using a certified Thunderbolt cable, connect Ensemble to a Thunderbolt port on your computer.
2.	 Connect other certified Thunderbolt devices to Ensemble’s remaining Thunderbolt port.

G1

G2

4

8

3

7

2

6

1

INPUT OUTPUT

5

A

C

B

D
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Multiple Units:

Two Ensemble Thunderbolts or an Ensemble Thunderbolt and an Element Series interface can be connected to 
the same system.

1.	Using a Thunderbolt cable, connect from a Mac with Thunderbolt 1, Thunderbolt 2, or Thunderbolt 3 port > to 
either of Ensemble’s Thunderbolt ports.

2.	Using a second Thunderbolt cable, connect from the remaining Thunderbolt port > to the Element Series 
interface, or second Ensemble.

3.	Using ADAT Optical (Toslink) cables, connect OUT of the first unit > to the IN of the second unit. Do the same 
in the opposite direction until all available optical connections are used.
•  Four optical cables will be required if the second unit is another Ensemble Thunderbolt or Element 88.
•  Two optical cables will be required if the second unit is an Element 46 or Element 24.
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Thunderbolt Notes

•  The two Thunderbolt 2 ports allow you to chain up to 6 Thunderbolt peripherals from your Mac.
•  Thunderbolt 2 is backwards compatible and can connect to Thunderbolt 1, Thunderbolt 2, or Thunderbolt 3 

Macs.
•  Under most circumstances, the order in which peripherals or ports are connected doesn’t matter.

•  Exception: If you’re connecting peripherals with different Thunderbolt speed ratings, connect the higher 
speed devices closer to your Mac in the chain.
•  i.e. Mac > Thunderbolt 3 devices > Thunderbolt 2 devices > Thunderbolt devices

•  Thunderbolt peripherals continue to operate when Ensemble is powered off. This ensures that displays, hard 
drives, or other essential equipment doesn’t lose connection to the computer when Ensemble is not in use.

•  A non-Thunderbolt device (i.e. Firewire, HDMI, DisplayPort, etc.) may be connected to the chain, but the 
adapter for the device must be placed at the end.

Note: Make sure that your Mac and cable has the Thunderbolt logo.
•  Some older Macs have mini DisplayPort connections that, while identical in appearance to a Thunderbolt port, 

do not support Thunderbolt peripherals.
•  Verify that the Thunderbolt logo is present on your Mac’s ports and your cable.

X Mini DisplayPort			   √ Thunderbolt Port

For Macs equipped with a USB-C port, check the computer’s hardware specifications to ensure they are 
Thunderbolt-3 enabled. If so, then Apple’s Thunderbolt 3 to Thunderbolt 2 adapter can be used.

Thunderbolt-3 Port				    Thunderbolt-3 to Thunderbolt-2 adapter

Note: Apogee cannot guarantee performance if utilizing an uncertified Thunderbolt device in the same chain as 
Ensemble. To see if a device is certified, please go to:  
https://thunderbolttechnology.net/products

https://thunderbolttechnology.net/products
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Ensemble Software

System Requirements
Computer: Thunderbolt equipped Mac
Memory: 4GB RMA minimum, 8 GB RAM recommended
macOS 10.10 or greater
Thunderbolt Cable

Download and Install Software
Before Ensemble will work with the computer, special software must be installed. The latest version of the 
software can be downloaded from the Apogee website at:
www.apogeedigital.com/support/ensemble-thunderbolt
￼

The version referenced in this document is Apogee Control 2.0 and is 
used for both Ensemble and Element Series. The download comes in 
the form of a .dmg image file. Open it to view the contents. Inside you 
will find four items:

•  Element Release Notes.pdf
•  Ensemble Thunderbolt Release Notes.pdf
•  Element Ensemble Installer.pkg
•  Element Ensemble Uninstaller.app

Double-click to launch the Ensemble Thunderbolt Software Installer.
pkg. A dialog box will appear with a series of steps to proceed. Follow the prompts to complete the installation. 
You will be required to restart your computer.

As a result of the software install:
•  Apogee Control software is placed in the Mac’s Applications folder (see page 40).
•  When connected, Ensemble Thunderbolt appears as an audio input/output device in Mac Sound System 

Preferences (see page 19).
•  Apogee Firmware Updater.app is placed in the Mac’s Utilities folder.

http://www.apogeedigital.com/support/ensemble-thunderbolt
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Update Ensemble Firmware

The first time Ensemble is used after the software installation, you 
will likely receive a prompt to update the firmware.

Warning: Do not disconnect power or interrupt the firmware 
update process before it is complete as this may damage the unit.

￼
1.	 Make sure Ensemble is connected to the computer and is 

powered on. Make sure only one Apogee device is connected.

2.	 If a prompt does not appear, manually open the Apogee 
Firmware Updater.app which is located in the Mac’s 
Applications > Utilities folder.

3.	 Select “Start Update”.

Follow any prompts that may appear.

Note: You may be asked to unplug and reconnect the 
Thunderbolt cable more than once.

4.	 When complete, the Hardware & Updater versions will 
match, and you can quit the updater.
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Connection Examples Diagram
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Front Panel Controls
Many Ensemble settings can be controlled from the front panel. For full control over all settings, use the Apogee 
Control Software (page 40).

Adjust the Input Gain
1.	 Turn the Input Controller knob to adjust the input gain for the selected channel.

￼

2.	 Select a different channel by pressing the Input Controller knob repeatedly until the 
desired input is highlighted. 

￼

3.	 Alternatively, press one of the Input Select buttons to jump directly to that input.

Accessing other Input Settings:
1.	 Once an Input Select button is illuminated, press it again to 

access the Input Settings screen.
￼

2.	 Turn the Input Controller knob to navigate up and down and highlight the different 
parameters.

￼

3.	 Press the Input Controller knob to change a parameter to a different setting.
￼

4.	 To exit the Input Settings screen, press the illuminated Input Select button. Otherwise, 
Ensemble will automatically exit after idling for 15 seconds.

For more information on the parameters of the Input Settings screen, see page 9.
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Adjust Output Volume
1.	 Turn Output Controller, Headphone 1, or Headphone 2 knob to adjust the respective output level.

2.	 Press the Output Controller, Headphone 1, or Headphone 2 knob to toggle mute on/off.

￼    ￼

Assignable Buttons
Assignable buttons A, B, C, & D can be programmed to perform different functions. Press an Assignable button 
to perform it’s programmed function.

•  Programming of the Assignable Buttons can only be done in the Apogee Control software’s Front Panel & 
Remote Control Assignments window. See page 51 and page 53 for more detailed information.

The factory default settings are:

A - Talkback - must hold button down
B - Clear Meters
C - Toggle G1/G2 output source between “Thru” and “From Software”
D - Toggle Mute function between Monitor Out and Headphones outputs
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Getting Started with Audio Software

Select Ensemble for Mac System Sound Output
To get sound from general audio applications such as iTunes and Safari to play out of Ensemble, it must be 
selected as the output device in Mac System Preferences.

•  Make sure you have already installed the most recent Ensemble Thunderbolt Software from the Apogee 
website before proceeding.

1.	 Click the  icon in the 
upper-left corner of your 
Mac’s display.

	

2.	 From the drop-down 
menu, select “System 
Preferences...”

3.	 In the System Preferences control panel, 
select “Sound”.

￼
4.	 At the top of the Sound Preferences 

panel, select the “Output” tab.

5.	 Under “Select a device for sound output:” click Ensemble Thunderbolt.

	 “Apogee Thunderbolt” when in Multi-Unit Mode

Now sound from iTunes or Safari will come through Ensemble’s outputs.
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Route Mac System Sound to Different Outputs

1.	 Open the Audio/MIDI Setup Utility, found in the Applications > Utilities folder of your Mac.

2.	 In the Audio Devices window, [Control+click] on Apogee 
Ensemble.

3.	 In the Menu that appears, select “Configure Speakers”.

￼

4.	 If playing a stereo audio file, select the Stereo 
Configuration.

5.	 Select the desired Ensemble output channel for 
each speaker assignment.
•  For example, if you want iTunes to play out 

of Ensemble channels 3 & 4, set Left Front to 
“Playback 3” and Right Front to “Playback 4”.

6.	 Select the Apply button.
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Select Ensemble in your DAW

Most professional applications have their own audio preferences that are separate from the Mac System 
Preferences. Basic steps for setting up Ensemble are provided. For more detail on this topic, refer to the 
documentation that comes with your recording program.

Select Ensemble in Logic Pro X

1.	 Go to Logic Pro X > Preferences > Audio.

2.	 In the Devices Tab, select “Ensemble” in the 
Output and Input Device drop-down boxes.

“Apogee Thunderbolt” when in Multi-Unit Mode

3.	 Start by setting the I/O Buffer Size to “64 
Samples”. This setting may need to be adjusted 
based on your computer’s performance.

4.	 Select “Apply Changes” and close the 
Preferences window.

Select Ensemble in Pro Tools

1.	 Go to Setup > Playback Engine.

2.	 In the Playback Engine drop-down box, select 
“Ensemble”.

“Apogee Thunderbolt” when in Multi-Unit Mode

3.	 Start by setting the H/W Buffer Size to “64 
Samples”. This setting may need to be adjusted 
based on your computer’s performance.

4.	 Select OK.
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Select Ensemble in Ableton

1.	 Go to Live > Preferences. Select the Audio Tab.

2.	 In Driver Type, select “CoreAudio”.

3.	 In Audio Input & Output Devices, select “Ensemble”.

“Apogee Thunderbolt” when in Multi-Unit mode.

4.	 Start by setting the buffer size to “64 samples”. This setting may need to be adjusted based on your 
computer’s performance.
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Monitoring the Input Signal

Using your DAW to Monitor
By default, Ensemble is configured for your recording software or DAW to perform the monitoring duty of 
passing your input signal on to your output. For instructions on configuring some of the major DAW programs 
with Ensemble, see page 21.

Enable Input Monitor in Logic Pro X

1.	 Open Logic Pro X > Preferences > Audio.

2.	 Make sure the box next to “Software Monitoring” 
is checked.

3.	 Select the “i” button in each track you’d like to 
input monitor.

Enable Input Monitor In Pro Tools

•	 Click the “i” button to enable Input Monitoring

Enable Input Monitor in Ableton 
Live

•	 In the track I/O section, set the Monitor switch 
to “Auto”, or “In”
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Using the Apogee Control mixers to Direct Monitor
If you do not have any recording software open, or do not want to use its monitoring function due to high latency 
(see “Understanding Latency” on page 59), then you can use one of the Low-Latency Mixers built into the 
Apogee Control software to monitor your signal instead.

Here’s a simple way to set this up:
1.	 Open Apogee Control and go to the menu File > Open Snapshot Template

2.	 Click the “Direct Monitoring” template so it’s highlighted, then click Load

Your outputs are now getting signal from the Mixer 1 of the 
Control software, and you will be able to hear your input 
signal pass through to your main and headphones outputs.

Using Logic Pro’s “Direct” button for Direct Monitoring

If you notice latency delay when using a high buffer setting, use the Direct button in the Device Control section of 
Logic’s mixer to eliminate that latency. You must have Logic Pro X 10.3.2 or higher to use this feature:

1.	 Open Apogee Control and make sure your Main and Headphones 
outputs are using a Playback source.

2.	 Open Logic Pro X and locate the track onto which you are recording 
from Ensemble.

3.	 Click the “Direct” button.

Note:
-- This will bypass any plugin fx applied to that track.
-- If bussing to an Aux track that has a time-based effect like reverb applied, that 

fx will continue to work and be heard.
-- This function only works with a single Apogee interface connected. It is not 

available in Multi-Unit mode.

For more information on this feature, see our KnowledgeBase article:
www.apogeedigital.com/knowledgebase/ensemble-thunderbolt/logic-direct-
monitoring/

http://www.apogeedigital.com/knowledgebase/ensemble-thunderbolt/logic-direct-monitoring/
http://www.apogeedigital.com/knowledgebase/ensemble-thunderbolt/logic-direct-monitoring/
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Guitar I/O
Introduction

Ensemble provides two high impedance (Hi-Z) inputs and two instrument level outputs on the 
front panel. The capabilities these connections provide are a powerful tool in your recording 
arsenal. From re-amping to setting up an instrument-level effects loop, the Ensemble’s 
Guitar Inputs and Outputs simplify tasks that previously required specialized equipment with 
complex setup and configuration steps.

Guitar Input Features

•	 Designed to accept a Hi-Z input signal from guitar, bass, keyboards, or other Hi-Z instruments.
•	 Dedicated circuit design different than rear panel instrument inputs.

•	 Class A JFET preamp circuit that provides the feel and responsiveness characteristic of the input circuit 
on a quality vintage guitar amplifier.

•	 “Bootstrapping” design provides an ultra-high impedance load, preserving the instrument’s tone and 
frequency response.

•	 Assigned to software input channels 11 and 12.

Guitar Output Features

•	 Impedance balanced instrument-level output designed to connect to guitar or bass amplifiers, or effects 
such as stomp-box pedals and processors, or similar devices.

•	 Dual mode switching.
•	 “Thru” setting provides a zero latency direct output for the instrument connected to the guitar input.
•	 “From Software” setting means only non-direct signals such as audio from a DAW or the Apogee Control 

Mixer is output.
•	 Unity Gain feature takes care of level matching the input vs output signals.

•	 Assigned to software output channels 11 and 12.

Re-Amping
Ensemble provides a powerful way to get your best guitar tracks in a two-stage process. The first stage focuses 
on capturing your performance in a recording track of your DAW. The second stage routes that performance 
through your amps and effect pedals, allowing you to tweak settings until it’s perfect so it can be recorded into 
your session.
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Stage 1: Record the Performance

The dry guitar signal is recorded directly onto a track in the DAW.

To do this on Ensemble:

1.	 Connect a guitar to a front panel guitar input on Ensemble.
2.	 Setup an audio track in your DAW to record from the guitar input (G1 = In 11, G2 = In 12). To keep things 

simple, leave Ensemble’s input gain at 0dB.
3.	 Record the performance in your DAW.

Monitoring as you Record

For the best performance, many players prefer to hear themselves through a guitar amp as they record.

a.	 Connect a guitar cable from Ensemble’s guitar out to an amplifier’s input.
b.	 Set the guitar output to “Thru”. This can be 

done with the front panel Assignable C button 
(page 51), or in Apogee Control’s Out tab of 
the Primary window (page 50).

When set to “Thru”, the guitar output sends a 
direct signal sourced from the guitar input jack. 
The resulting signal to your effects pedals and/or 
amplifier produces the same sound as if the guitar 
was connected directly.
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Stage 2, Part 1: Playback Through Your Guitar Rig
The dry guitar recording is played out to your effects and/or amplifier.
￼

To do this on Ensemble:

1.	 Route the DAW’s guitar track to Ensemble’s guitar output (G1 = Out 11, G2 = Out 12).
2.	 Connect a guitar cable from Ensemble’s guitar out to an amplifier’s input. You can include effects pedals/

processors between Ensemble and the amplifier if desired.
3.	 Set the guitar output to “From Software”. This can be done with the front panel Assignable C button, or in 

Apogee Control’s Out tab of the Primary Window (page 50).
4.	 Play the DAW track to hear the performance played through the effects and amplifier. Adjust and tweak the 

settings of your effects and/or amplifier until the desired sound is achieved.

Stage 2, Part 2: Record the amp onto a separate DAW track
The sound of the amplifier is recorded, usually with a microphone, onto another track in the DAW.
￼

1.	 Place a microphone in front of the amp and connect the mic to an input on Ensemble’s rear panel.
2.	 Make the appropriate settings to get the mic input working using Ensemble’s Front Panel controls (page 17), 

or Apogee Control’s Input settings in the Mix tab of the Primary window (page 45).
3.	 In your DAW, setup a new audio track, and set the input source to record the microphone.

This process can be repeated several times. Experiment by swapping out amplifiers, changing the order and 
settings of effects pedals and processors, or moving the microphone in front of the amp to get different sounds.
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Notes about re-amping with Ensemble:

If you decide to use Ensemble’s guitar input preamp to increase the dry guitar signal level into your DAW, be 
aware that this will also increase the track’s output level to Ensemble’s guitar output.

•	 If the intention is to keep the signal coming out of Ensemble at the same level as the original input, use the 
“Unity Gain” checkbox in Maestro’s Output tab window to tri the output level to match the original input.

•	 Unity gain does not compensate for any changes made in the DAW. Therefore, do not alter the dry guitar 
track fader, or change the EQ or insert any plugins in your DAW as doing so can compromise the signal to 
Ensemble’s guitar output.

Why is it important that the Output level be the same as the input level?

On many guitar amplifiers, a change in the input level can significantly change the sound of the amp. Since most 
amps sound best with a guitar connected directly to it, Ensemble was designed to preserve the original guitar 
signal to achieve this result. Features such as “Thru” and “Unity Gain” are used for this purpose.

As with many recording techniques, this is more of a guideline than a rule. Feel free to experiment with different 
levels and settings to achieve unusual sounds and unique results.

Unity Gain
Unity Gain lowers the guitar output level by the same amount the guitar input is 
increased by the preamp, maintaining unity in level between the guitar input and guitar 
output jacks. For example, if the preamp is set to boost the input signal by +10dB, 
then so that the guitar output isn’t also 10dB louder, the attenuator lowers the output 
by that same amount to maintain unity.

Important: Document the preamp gain setting used when the recording is made. 
Since Ensemble adjusts the attenuator based on the the preamp setting, the preamp 
gain value may need to be recalled if re-amping at a later date.

Guitar I/O Circuit Diagram
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Inserting Effects Pedals
Ensemble’s Front Panel Guitar inputs and outputs are perfect for inserting external hardware processors 
designed for Hi-Z and instrument level signals - such as pedal style effects - into a track. This is not limited to 
guitar tracks alone, but allows you to also run vocals, drums, and other recordings through these types of effects 
for a unique sound.

NOTE: If inserting hardware with traditional +4dBu or -10dBV line-level inputs and outputs, it’s best to 
utilize the inputs and outputs on the rear-panel of Ensemble.

1.	 Route signal from your DAW to the G1 (Out 11) or G2 (Out 12) outputs.
2.	 Using a regular unbalanced 1/4” instrument cable, connect from the G1 or G2 Output to the Input of your 

first pedal.
3.	 Connect another 1/4” cable from the output of your last pedal to Ensemble’s G1 or G2 Input.

NOTE: If sending from Ensemble’s G1 output, use Ensemble’s G1 input to return the signal.
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Main Features
Analog Audio Inputs
Ensemble’s 12 analog audio inputs provide a multitude of connectors and options coupled with Apogee’s 
dynamically optimized preamps and premium circuit design that provide for all the interconnections you need 
with your external gear.

Guitar Inputs
See the Guitar I/O section on page 25.

Channels 1 - 4 Features
Combi Jacks

Rear Panel inputs 1-4 feature a combination (combi) input connector that is able 
to receive an XLR or 1/4” plug through the same jack. Set the input source via 
Ensemble’s front panel controls (page 17), or from the Apogee Control software 
(page 46) according to the input connector being used.

•	 When using the 1/4” input, the source must be set to “Inst”.
•	 When using the XLR input, the source may be “Mic”, “+4dBu”, or “-10dBV”.

When Input Source is set to:

Mic	 - The XLR input is sent to the microphone preamp circuit.
Inst	 - The 1/4” input is sent through a Hi-Z to Low-Z conversion circuit, then the microphone preamp circuit.
+4dBu	 - The XLR input bypasses the microphone preamp circuit and sent to the A/D converter.
-10dBV	- The XLR input is converted to +4dBu, bypasses the microphone preamp, and sent to the A/D 
converter.
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Channel 1 & 2 Analog Insert Send/Return jacks

The Insert Send and Return jacks are for connecting external equipment - such as a 
compressor, EQ, or other signal processing gear - into the input signal chain. Engage 
the Insert via Ensemble’s front panel controls (page 17), or from the Apogee Control 
software (page 46) according to the input connector being used.

1.	 Connect a 1/4” cable from Insert Send jack to the external hardware’s Input jack.
2.	 Connect another 1/4” cable from the output of the external gear to Ensemble’s Insert Return jack.
3.	 In Apogee Control, go to the Mix View of the Primary Window (page 45).
4.	 Select the Insert “In” button to toggle the insert on/off.

Special Notes:
•	 The Send/Return jacks can accommodate balanced TRS as well as unbalanced TS 1/4” connections.
•	 The Send jack is always active and can be used as a Post-Preamp direct line-out (+4dBu).
•	 The Return jack can be used as a 1/4” balanced line-in (half-normaled, +4dBu), and is only active when the 

“In” button is selected.

Channels 5 - 8 Features
Rear-panel inputs 5 - 8 feature an XLR jack for connecting microphones or line-level 
signals. Set the input source via Ensemble’s front panel controls (page 17), or from the 
Apogee Control software (page 46) according to the input connector being used.

When Input Source is set to:

Mic	 - The XLR input signal is sent to the microphone preamp circuit.
+4dBu	 - The XLR input signal bypasses the microphone preamp circuit and sent to the A/D converter.
-10dBV	 - The XLR input signal is converted to +4dBu, bypasses the microphone preamp, and sent to the A/D 

converter.

Analog Input Circuit Diagram
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Built In Mic
Ensemble features a built-in mic on the front panel that can be recorded, or used for the Talkback function (page 
34).

Recording the Built-In Mic

Ensemble’s Built-In Mic can be recorded into your computer in the same way as the other inputs on the 
Ensemble. 
•	 Because Ensemble requires inputs to be assigned as pairs, the Built-In Mic is assigned to channels 9/10.
•	 Even though the mic assigned to two channels, it is not stereo. Instead the mono signal is duplicated to both 

channels.
•	 In your DAW, set the track’s Input Source to Channel 9 or Channel 10.
•	 The Built-In Mic gain is controlled from the Mix View of the Primary window in Apogee Control (page 45).

Analog Audio Outputs
Ensemble provides 16 analog outputs for connecting to your external gear.

Monitor Out L1 & R2
Ensemble’s Monitor Out L1 & R2 are designed to connect to studio monitor speakers. These outputs 
are controlled by the Output Controller knob, but can be set to a fixed line-level output via the Device 
Sidebar of the Apogee Control software. See the Monitor Control Center section on page 36 for more 
information on configuring these outputs.

•	 Balanced 1/4 TRS outputs
•	 Can be configured as a fixed line-out
•	 Can be set to +4dBu or -10dBV via the Apogee Control software (page 49)

Analog Out 3-10
Ensemble provides additional balanced analog outputs via a 25-pin d-sub connector. 
Connect an analog out breakout cable to this connector to access these outputs.

These outputs are set as fixed line-level outputs by default, but outputs 3-10 can be 
adjusted by the Output Controller knob when multiple speaker sets (page 36) or 9.1 surround monitoring (page 
37) is enabled. See the Monitor Control Center section on page 36 for more information on configuring these 
outputs.

•	 Balanced 25-pin D-Sub Output
•	 Can be set to +4dBu or -10dBV via Apogee Control (page 49)
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Guitar Outputs
See the Guitar I/O section on page 25.

Digital I/O
Ensemble provides multiple ports of digital inputs and outputs, providing up to 18 channels of digital I/O for 
connectivity to your digital gear.

Optical
Two pairs of optical (Toslink) in and out ports are provided. These ports can be configured 
independently via the Device Sidebar of the Apogee Control software (page 44) to use 
ADAT/SMUX or S/PDIF protocols, and are capable of sample rates between 44.1 - 96k.

Coaxial
Coaxial digital in and out ports are provided and are capable of sample rates between 44.1 - 192k.

S/PDIF		 44.1 - 192k Sample Rates	 - 2 channels of audio provided

ADAT

SMUX

S/PDIF

44.1 - 48k Sample Rates

88.2 - 96k Sample Rates

96k Sample Rates

- 8 channels of audio provided per port
- 16 channels total when using both ports

- 4 channels of audio provided per port
- 8 channels total when using both ports

- 2 channels of audio provided per port
- 4 channels total when using both ports
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Monitor Control Center
Ensemble is equipped with several monitoring features to provide for your monitoring needs.

Talkback
- The talkback feature is activated by holding down the Talkback button in the Apogee Control Tool bar.
- It can also be activated by an assignable button on the Ensemble’s Front Panel or optional Control hardware 

remote (page 51).
- When talkback is activated, the monitor outputs are automatically dimmed (-15dB).

Selecting the Talkback Source
There are three major sources you can use for Talkback:
- Ensemble’s Front-Panel mic
- Any CoreAudio input device on your Mac

•	 If the device appears on the INPUT list of Mac Sound Preferences, it can be used as the talkback 
source. Examples of such devices are your Mac’s built-in mic, a USB mic, an Apogee ONE, the line-input 
jack on the Mac, etc.

Note: if using a multi-channel CoreAudio devices such as Duet, talkback will always use Input 1 of that device.

1.	 Open Apogee Control and click the System button to reveal the system sidebar.
2.	 Under Talkback Source, select your device.

If choosing a device such as Apogee ONE or Duet or a USB mic, the talkback mic’s gain is controlled on that device.
If choosing the Mac’s built-in mic, the input gain is controlled through the Mac Sound Preferences:

1.	 To adjust the Mac’s built-in microphone’s gain, open Mac System Preferences > Sound.

2.	 In the INPUT tab, select Internal Microphone from the list, then use the Input Volume slider to adjust the 
mic’s gain.



35

Apogee Ensemble Thunderbolt | User’s Guide 

Choosing the Talkback Destination

The Talkback can be sent to any Playback channel. From there it can be sent directly to the headphone or main 
outputs, or can be directed through any of the Mixers first.

To select the Talkback Destination:
1.	 Open Apogee Control and click the System 

button to reveal the system sidebar.
2.	 Under Talkback Destination, select your desired 

Playback Channel.

Setting an Assignable Button to activate Talkback

From the factory, assignable button A on Ensemble’s Front Panel is programmed to activate Talkback. However, 
any of the Assignable buttons can be set to this function:

1.	 Open the Remote window in the Apogee Control software.

2.	 Under the Front Panel Assignments section, click the 
button under A, B, C, or D and select “Engage Talkback”.

3.	 The Talkback function is on while the Assignable button 
is held down (momentary).

Setting a button on the Control hardware remote for Talkback

1.	 Open the Remote window in the Apogee Control software. 

2.	 Under the Remote Control Assignments Section, click under the desired button and from the menu that appears, 
choose a Talkback option:

•	 Momentary Talkback
- The button must be held down to maintain talkback.

•	 Toggle Talkback
- Press once to turn Talkback on.
- A second press turns Talkback off.
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Speaker Outputs
Ensemble has the ability to control the volume of studio monitor speakers that are connected directly to the analog 
outputs. By default, the output volume knob adjusts the Monitor outputs 1-2. The volume control can be expanded to 
include up to 3 stereo speaker sets, or a 5.1, 7.1, or 9.1 surround speaker setup.

How to Set the Monitor Outputs as a fixed Line-Out

This setting changes the Monitor Outputs from a variable volume controlled by the Output Controller knob to a fixed 
output at the full +4dBu or -10dBV reference level. This setting is convenient for connecting Ensemble to an external 
monitor control devices such as a mixing console.

1.	 Open Apogee Control and click the device 
button to reveal the Device sidebar.

2.	 Under the Main Output Format, select “Line”.

Note: This disables Ensemble’s Monitor Output level control.

How to Setup and Use Multiple Speaker Sets

It is possible to connect up to three pairs of stereo speakers monitors and toggle between them. This is useful to 
check how a mix sounds through different speakers and systems.

1.	 Connect the first pair of speakers to Monitor Out 1-2, the second pair to Analog Out 3-4, and if desired a 
third pair to Analog Out 5-6.

2.	 Open Apogee Control and click the Device 
button to reveal the Device Sidebar.

3.	 From the Main Output Format drop-down box, 
select “2 Speaker Sets” or “3 Speaker Sets”.

4.	 Click the Speaker Set 1, 2, or 3 button to select which speaker set is active.

Note: To activate multiple speaker sets simultaneously, hold down [command ⌘] and 
select another speaker set button.
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How to connect and configure a Surround Speaker Setup

When using Ensemble with a surround speaker setup, the first set of outputs can be configured as speaker 
outputs suitable for connection to a 5.1, 7.1, or 9.1 speaker system. With this configuration, turning the Output 
Controller knob will adjust volume of all applicable outputs simultaneously. Here’s an example for a 5.1 speaker 
setup:

•	 Monitor L: Front Left
•	 Monitor R: Front Right
•	 Output 3: Center

•	 Output 4: Sub-woofer
•	 Output 5: Left Surround
•	 Output 6: Right Surround

Note: To access outputs 3-6, you will need a breakout cable that converts the DB25 connector to 8 XLR male 
plugs.

3.	 From the Main Output Format drop-down box, select 5.1 (Out 1-6).

Now when you adjust the Ensemble’s output volume, it will affect outputs 1-6 
simultaneously.

Adjust for Volume Differences Between Speakers

There may be cases where the perceived volume of one, two, or three speaker sets, or a speaker in a 
surround setup, is slightly different from the others. The output Trim controls in Apogee Control can be used to 
compensate for this so all speakers produce the same perceived volume levels.

1.	 Open Apogee Control and click the Out tab at the top of the Primary Window.

Between Analog Level and Source settings are your trim controls.

2.	 Click then drag up or down on the trim control to adjust the value.
•	 Alternatively, you can double-click the number in the middle and 

manually enter in a value.

Note: Trims only allow a reduction in signal level. Lower the trim of the speaker or speaker set that is too loud.
If a speaker or speaker set is too quiet, then leave the trims of those speakers at maximum (zero) and lower the 
trim of all the other speakers.

1.	 Connect your speakers to Ensemble’s analog 
outputs 1-6.

2.	 Open Apogee Control and click the 
Device button to reveal the Device 
Sidebar.  

A standard 5.1 surround setup is as follows:
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Clocking with External Equipment
When connecting digital audio cables between Ensemble and another digital audio device, a clocking 
relationship must also be set. Whether connecting two or more devices, one must be set as the clock master, 
and all other devices must be set as clock slaves.

Configure Ensemble as Clock Master

1.	 Open Apogee Control and click the System button to reveal the System Sidebar. 

2.	 Click the Clock Source dropdown button and choose “Internal”.

3.	 When Ensemble is using its internal clock, the front panel output display will show “INT”.

•  Clock signal is sent to all of Ensemble’s digital audio outputs and BNC Word Clock 
output.

4.	 Connect a digital audio cable (optical or coaxial) out of Ensemble and into the external equipment.
Or connect a BNC Word Clock cable from the OUT of Ensemble to the IN of the external equipment.

5.	 Make the appropriate settings on the External equipment to set it as a slave.

•  The sample rate must match on both devices. Though the slave device may automatically switch to the 
appropriate sample rate, this may not always occur and the sample rate will need to be set manually.
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Configure Ensemble as Clock Slave

1.	 Set the external device as the clock master.

2.	 Connect a digital audio cable (optical or coaxial) out of the external device and into Ensemble. Or connect a 
BNC Word Clock cable out of the external gear to Ensemble’s BNC IN port.

3.	 Open Apogee Control and click the System button to reveal the System Sidebar.

4.	 Click the button under Clock Source and select the appropriate external connection from the drop-down 
menu.

Set the Clock Source to “ADAT”, “SMUX”, or “SPDIF OPTICAL” 
when using an optical cable. Ensemble’s front panel will also 
reflect the source.

Set the Clock Source to “SPDIF Coax” when using a coaxial 
audio cable. Ensemble’s front panel will also reflect the source.

Set the Clock Source to “Word Clock” when using a BNC word 
clock cable. Ensemble’s front panel will also reflect the source.

•  BNC is the preferred method of transferring digital clock. Use this connection whenever 
possible.

If Ensemble doesn’t receive or is unable to lock to an external clock source, the display’s clock 
source indication will turn red, and the sample rate will blink.

When this happens, check your connections for a bad or misconfigured cable, and make sure 
the sample rate of the master and slave devices are set to the same value.
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Apogee Control Software
Control of your all your Ensemble’s settings and features is available through the Apogee Control software.
After installing the Software, you’ll find the Apogee Control.app in your Mac’s Applications folder.

Apogee Control consists of four windows:

1.	 Essentials
2.	 Primary
3.	 Hover Help
4.	 Front Panel & Remote Control Assignments
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Essentials Window

This window provides simple and compact controls for Input Channels and Monitoring. Its orientation can be 
changed between vertical and horizontal so that it can be placed to the side or end of your recording software.

1.	 Orientation Button - Switches the Essentials Window between horizontal and vertical view.
2.	 Analog Input Channels - Provides settings for the analog inputs.

•  The buttons at the bottom of each input coorespond to the Input Channel Settings (see page 46): 
Phantom Power (48V), Soft Limit (SL), Group (G), Invert Polarity (∅), Hi-Pass (⦧), and Insert (IN).

3.	 Outputs - Headphones and speaker outputs settings are provided.
•  The buttons at the bottom correspond to the Output controls: Mute (M) Dimming (D), Sum-to-Mono (Σ)

4.	 Clear Meters - Clear the Peak or Over indicators from the level meters.
5.	 Talkback - Engages talkback to communicate with those wearing headphones. Set the Talkback source and 

destination in the System Sidebar (see page 43).
6.	 Mute All - Mutes Headphones and Main speaker outputs.

When connected to a second Ensemble or an Element Series Thunderbolt interface, inputs and outputs for both 
units are displayed.
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Primary Window

All features and settings of Ensemble can be controlled from the Primary Window. It is broken down into several 
sections:

Tool Bar
The Tool Bar is always visible at the top of the Primary Window. It provides the ability to show/hide the System 
Sidebar, Device Sidebar, Essentials Window, Front Panel & Remote  Control Assignments Window, and Hover-
Help Window. It also has buttons for Clear Meters, Talkback, and Mute All Outputs.

1.	 System Sidebar Button
2.	 Device Sidebar Button
3.	 Essentials Button
4.	 Front Panel & Remote  

Control Assignments

5.	 Mix View Button
6.	 Out View Button

7.	 Clear Meters Button
8.	 Talkback Button
9.	 Mute All Button
10.	 Hover Help Button
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System Sidebar
Provides System-wide settings that apply to your recording system as a whole.

1.	 System Status Display - Displays the status of the connected hardware.
•  Green - System is ready: hardware is connected and recognized, and the digital clock is 

locked to the Clock Source
•  Red - System is not ready. Either the hardware is not connected or the system is not 

locked to the Clock Source

2.	 Master Device - When two Ensembles, or an Ensemble & Element are connected, select 
one as the Master Device. The Master Device acts as the clock master.

3.	 Clock Source - Selects the system clock source. The Following sources may be selected:
•  Internal: Ensemble is clocked from its internal crystal
•  Word Clock: Ensemble is clocked from an external word clock signal connected to the 

rear panel BNC input
•  SPDIF Coax: Ensemble is clocked from a Coax digital audio input
•  SPDIF Optical 1-2 or 3-4: Ensemble is clocked from a SPDIF optical digital audio input
•  ADAT 1-8 or 9-16: (Only sample rates 44.1 & 48k) Ensemble is clocked from an ADAT 

optical digital audio input
•  SMUX 1-4 or 5-8: (Only sample rates 88.2 & 96k) Ensemble is clocked from an SMUX 

optical digital audio input

Note: ADAT & SMUX not available when in Multi-Mode.

4.	 Sample Rate - Sets the Ensemble system Sample Rate. In some cases this setting may be 
overridden by software running on the computer (i.e. When a DAW session project is open).

Note: Multi-Mode has a max Sample Rate of 96k.

5.	 Peak Hold - Sets the time that peak indications are held on the level meters.

6.	 Over Hold - Sets the time that over indicators are held on the level meters.

7.	 Talkback Source - Select the source of the Talkback Signal. If your Mac is equipped with a 
Built-in Mic, select Built-in Mic as the source.

8.	 Talkback Destination - Talkback signal is sent to the selected Playback channel.

9.	 Keyboard Volume - The audio system may be configured so that the Mac keyboard 
volume controls set the output level of Element’s Main or Headphone outputs.
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Device Sidebar
The Device Sidebar provides settings that are specific to the Ensemble interface connected to the Mac.

1.	 Device ID - Identifies the hardware connected to the Mac system.
	 Clicking this button causes the displayed hardware to flash its status light for three seconds.

2.	 Main Output Format - Sets the format of the analog outputs:
•  Line - Monitor Out 1/2 are configured as line outputs. Functions such as level control, 

Mute, Dim, and Sum to Mono are disabled.
•  Stereo - Monitor Out 1/2 are configured as speaker outputs (with all monitor functions 

available). Outputs 3-10 are configured as line outputs.
•  2 Speaker Sets - Monitor Out 1/2 and outputs 3/4 are configured as two pairs of stereo 

outputs. Switch between the stereo pairs with the Speaker Select buttons. These outputs 
are adjusted simultaneously with the Output Controller knob. 

•  3 Speaker Sets - Monitor Out 1/2 and outputs 3-6 are configured as three pairs of stereo 
outputs. Switch between the stereo pairs with the Speaker Select buttons. These outputs 
are adjusted simultaneously with the Output Controller knob.

•  5.1 (Out 1-6) - Monitor Outputs 1/2 and Analog outputs 3-6 are configured as speaker 
outputs, suitable for connection to a 5.1 speaker system. These outputs are adjusted 
simultaneously with the Output Controller knob.

•  7.1 (Out 1-8) - Monitor Outputs 1/2 and Analog outputs 3-8 are configured as speaker 
outputs, suitable for connection to a 7.1 speaker system. These outputs are adjusted 
simultaneously with the Output Controller knob.

•  9.1 (Out 1-10) - Monitor Outputs 1/2 and Analog outputs 3-10 are configured as speaker 
outputs, suitable for connection to a 9.1 speaker system. These outputs are adjusted 
simultaneously with the Output Controller knob.

3.	 Optical 1 & 2 Format - Determines which audio format is transmitted and received through the optical In and Out ports.
•  SPDIF: The two-channel SPDIF audio format is transmitted or received through the selected port’s In or Out 

connections. This format is capable of utilizing a maximum sample rate of 96kHz.
•  ADAT/SMUX: The multi-channel ADAT or SMUX format is transmitted or received through the selected ports.

‣‣ The ADAT protocol is used for sample rates of 44.1kHz - 48kHz allowing up to 16 channels of digital I/O through 
Port 1 and Port 2.

‣‣ The SMUX protocol is used for sample rates of 88.2kHz - 96kHz allowing up to 8 channels of digital I/O through 
both Port 1 and Port 2.

Multiple Units Device Sidebar
When in Multi-mode with another Ensemble or Element Series, the Device Sidebar 
changes to show the Output Format and Output Level of both devices, while reflecting the 
loss of the Optical options.
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Mix View
The Mix View of the Primary Window is separated into an INPUT channel section, and a MIXER channel section.

Keyboard Navigation
The orange circle around either your Input Gain control or Monitor Output volume controls is called the Focus 
Ring. It is part of the Apogee Control software’s keyboard navigation feature.
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Channel Section
This portion of the Primary Window displays Channels for Analog input, Digital input, and Playback from audio 
software.

1.	 Channel Top Label - Indicates the channel’s source. Can be renamed by clicking the label and typing a user-customized 
label. To restore to the default text, delete the text and press “Return” on your keyboard.
*These labels are transmitted to your DAW.

2.	 Channel View Button - Show the Channel View pop-up to view/hide various 
channels.
* Channels are disabled when hidden so audio signal will not pass.
•  Analog Input Channels - Corresponds to the physical analog input 

connections on your Element interface.
•  Optical Input Channels - Corresponds to the physical optical input 

connections on your Element interface.
•  Playback Channels - Corresponds to the virtual signal path from your 

Mac’s software outputs.

3.	 Input Channel Level Meter - Shows the post-converter digital signal level coming into the channel.
4.	 Input Icon - Shows the input type selected from the Analog Level drop-down.

5.	 Analog Level - Use this drop down menu to choose the analog level for each A/D conversion channel.
•  Choose Mic when connecting microphones, direct boxes, or any devices that needs to run through a microphone 

preamplifier. -XLR Input only.
•  Choose Inst when connecting a guitar, keyboard, or any high impedance (Hi-Z) instrument to the 1/4” input (balanced 

TRS or unbalanced TS). The signal is sent through a Hi-Z to Low-Z conversion circuit before being sent through the 
microphone preamplifier circuit.

•  Choose +4dBu when connecting to “pro” gear, such as an external mic pre, compressor, or EQ, with outputs at a 
+4dBu nominal level.

•  Choose -10dBV when connecting to “semi-pro”, hi-fi, or musical instrument gear with outputs at a -10 dBV nominal 
level.

6.	 Input Gain Control - Use to adjust the gain of the microphone preamp. Not available when the input is set to +4dBu or -10dBV.

7.	 Input Settings - Provides options for the various inputs:

•   Phantom Power: Use this button to enable 48 volt phantom power on the corresponding Analog In channel. 
Condenser mics without their own power supply require 48 volt phantom power to operate.

•   Group: The input gain controls of adjacent odd-even channels are adjusted simultaneously. Any level offsets 
that exist before inputs are grouped will be preserved after a group is chosen.



47

Apogee Ensemble Thunderbolt | User’s Guide 

•   Soft Limit: Select “On” to engage. This option begins to attenuate transient peaks at a threshold of -4dBfs (see 
page 61).

•   Polarity Invert: Use this button to invert the polarity of the input signal.

•   High-Pass Filter: Use this buton to engage an 80Hz, 12dV/octave high-pass filter on the input.

•   Insert: Directs signal from the Input 1 or 2 Insert Return jack to the A/D converter (Insert Send is always active 
and can be utilized as a preamp line-out).

Mixer Section
The mixer section provides several Direct Monitor mixers, and a special FX Send mixer for workflows that utilize 
the low-latency Direct Monitoring features of your Ensemble Thunderbolt interface.

1.	 Mixer 1 - Signal from each channel can be sent through this 
mixer by raising the corresponding Mixer 1 Channel Fader.

•	 This mixer’s Master signal can then be selected as a 
source for the Headphones or Main outputs, providing a 
low-latency direct monitoring signal path.

•	 This mixer can also be sent back into the computer as a 
separate stereo input available in your DAW.

•	 The faders on this mixer affect the fader send signal of the 
other Mixers and FX Send (when those other mixers’ Pre 
Fader button are not engaged).

2.	 Mixers 2, 3 - Signal from each channel can be sent through 
these mixers by raising the individual Mixer 2, or 3 Channel 
Fader.

•	 This mixer’s Master signal can then be selected as a 
source for the Headphones or Main outputs providing a 
low-latency direct monitoring signal path.

3.	 FX Send - Signal from each channel can be sent through this 
mixer by raising the individual FX Send Channel Fader.

•	 This Mixer is sent back into the computer where it shows 
up as an extra stereo input available in your DAW. This 
signal can be used on an Aux track that has a Reverb 
or Delay or other effects plugin, allowing effects to be 
applied to a Direct Monitoring situation which would 
otherwise be completely dry.

4.	 Pre Fader Button
•	 When engaged, the channel signal from the mixer 2, 3, or FX Send mixer is sent to that mixer’s Master fader based 

only on that mixer’s channel fader level. This signal level is not affected by the position of the Mixer 1 fader (Pre-
fader).

•	 When not engaged (Post-fader), the channel signal from this mixer will also be affected by the Mixer 1 fader position. 
This means that in addition to the level changes by the fader on this mixer 2 or 3, moving the Mixer 1 fader on this 
same channel will further alter the signal level going to the mixer 2, 3 or FX Send mixer master.

5.	 Mixer View buttons - View or Hide mixers using this button.
*Mixers are always ACTIVE. A mix will continue working even when hidden.

6.	 Channel Fader - Set the level of the channel signal in the mixer master stereo output.
7.	 Mixer Channel Pan Control - Set the left-right placement of the channel signal in the mixer master stereo output.

•	 Option-click to reset the pan to center (0) or Option+Command-click to set all pans in that mixer to center (0).
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8.	 Channel Mute button - Cut the signal routing to the mixer stereo output. Command-click to cut all channels.

9.	 Channel Solo button - Mute all channels that do not have this solo button engaged in this mixer. Command-click to solo 
all channels.

Note: Engage Solo-Safe mode on a channel by Control-Clicking the Solo button on a channel. This prevents this 
channel from being muted when another channel in the mixer has solo engaged.

 A solo-safe engaged track will display a colored “S” within the Solo button

10.	 Channel Mono/Stereo button - Set the channel for a mono or stereo signal path. When set to stereo, odd-even 
adjacent channels are combined.
•	 To adjust a stereo channel’s individual input settings, use the arrow buttons that appear next to the Analog Level 

Setting. 

11.	 Channel Aux Label - This secondary label is a convenient way to enter session-specific information, such as the 
performer whose input appears on the channel. This label is not transmitted to the audio software (DAW).

Monitor/Output Section
The Monitor/Output Section is where you select what you hear in the outputs, and control the volume of the 
various outputs. The Output Level Meters are also a useful diagnostic tool to see if signal is be present at the 
various outputs.

1.	 Output Level Meters - Displays the pre-conversion digital audio level being sent to that output. 
Therefore these meters are not affected by the Main or Headphones output level control.

2.	 Output Level Control - Set the listening level of the Main or Headphone outputs.

3.	 Output Source Selector - Selects the sound source for each output. The options are:
•	 Playback - Sends a playback channel stereo signal directly to this output, bypassing all mixers.
•	 Mixers - Send the stereo signal from this mixer’s Master to this output.
•	 Hardware Inputs - Signal from the Ensemble input is sent directly to this output.

4.	 Output Mute button - Toggles the Mute on/off for this output.

5.	 Output Dim button - Reduces the output listening level by -15dB.

6.	 Sum-To-Mono button - Collapse left and right signals to mono at the output. This combined signal 
is sent through both Left and Right Outputs and is useful for verifying the mono-compatibility of a 
stereo mix.

7.	 Speaker Set Select Buttons - Only shown when the Devices Sidebar > Main Output Format is set 
to “2 Speaker Sets” or “3 Speaker Sets”.
•	 Click one button to activate that set.
•	 Command+Click to activate multiple sets simultaneously.
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Out View
The Out View of the Primary Window shows the settings and level meters for the analog and digital outputs.

1.	 Hardware Output Label - Indicates the analog or digital hardware output.

2.	 Output Channel Level Meter - Shows the digital signal level before the D/A conversion.

3.	 Output Icon - Indicates which output’s volume level is controlled by the Main Output volume control, and which are 
fixed-volume line-level outputs.

4.	 Analog Level - Set the output level for each analog channel. Match this level with the analog gear to which Ensemble is 
connected.
•	 Choose +4dBu when connecting to professional line level equipment.
•	 Choose -10dBV when connecting to “semi-pro”, hi-fi, or consumer equipment.

5.	 Output Trim Control - Use to adjust the analog output stage for precise calibration between speakers (see page 37).
•	 Option+click to reset to 0. Command+click to reset all channels to 0.

6.	 Hardware Output Source - Set the signal source for the pair of hardware analog or digital outputs. 
•	 Choose a Playback source to route audio directly from your DAW.
•	 Choose a Mixer source to route audio from a Symphony Control mixer.
•	 Choose a Hardware Input source to route audio directly from an I/O Module input.
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7.	 Guitar Output Analog Level- Determines whether the guitar output gets its signal directly from 
the Guitar input or from the computer’s audio software.

•	 Thru - The signal from the guitar input is passed directly to the guitar output. Guitar input 
signal continues to also pass to the computer’s software inputs.

•	 From Software - Only audio coming from the computer is heard. This setting is useful for 
playing back audio from a DAW to an instrument amplifier.

8.	 Unity Gain - Attenuates the Guitar Out level to counter the gain boost of the Guitar In preamp.   

How Unity Gain works:
-- As you raise the guitar input preamp, this increases the guitar’s audio signal to your computer recording software.
-- When playing this recording back through Ensemble’s guitar output jack, the signal increase is maintained.
-- If you want the guitar out signal to be lowered to match the original input signal, activate Unity Gain.

•	 For every dB that the preamp increases the input signal, the Unity Gain feature will lower the Output Trim by that 
same dB value.
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Front Panel & Remote Control Assignments Window

The Front Panel & Remote Control Assignments Window provides settings to configure the optional Apogee 
Control hardware remote control, as well as the four Assignable buttons on Ensemble’s front panel. To open this 
window choose Window > Remote, type Command+4, or click on the Remote toolbar button. 

The nine buttons at the top of the window - 1-4, A-D and Control Knob - are used 
to define the function of the Remote’s hardware function buttons. Click any button 
to reveal a menu of assignments.

The four buttons at the bottom of the window - A-D - are used to define the 
function of the Assignable buttons on Ensemble’s front panel. Click any button to 
reveal a menu of assignments.

The following functions apply to the Remote control device.

None	 - When a button is assigned to None, it does nothing.

Mute Panic	 - Mute the Headphones and Main outputs of all connected units.
- Tapping the button again doesn’t un-mute the signal - it must be un-muted 

in Apogee Control software. 

Mute Speakers	 - Mute the Main speaker output.

Mute Headphones - Mute the Headphone outputs of all connected interfaces.

Mute All Outputs	 - Mute the Main and all Headphone outputs; tap again to unmute.

Mute Toggle Headphone/Speaker - Toggle between two states:

1.	 All Headphone outputs muted and the Main speaker output unmuted.
2.	 All Headphone outputs unmuted and the Main speaker output muted.

- When recording in the same room as speakers, this function provides one button 
switching between recording with headphones and listening back over speakers.

Dim Speakers		  - Lower the Main speaker output by -15dB.

Dim Headphones 	 - Lower the Headphone outputs of all connected interfaces by -15dB.

Dim All Outputs	 - Lower the Main and all Headphone outputs by -15dB.

Mono Speakers	 - Sum the stereo Main speaker output to mono (when two interfaces are 
connected, Master interface only).

Mono Headphones - Sum the Headphone outputs of all connected interfaces to mono.

Mono All Outputs	 - Dim the Main and all Headphone outputs.

Toggle Speaker Sets - When Main Output Format (Device sidebar) is set to 2 or 3 Speaker Sets, 
this will cycle playback to the next speaker set with each button press.

Select Speaker Set 1, 2, 3 -  The Main output will jump immediately to the selected speaker set. 
Only applies when Main Output Format is set to 2 or 3 speakers sets.
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Set Main Out to Reference Level - Set the Main output level to a predetermined reference 
level, from -64 to 0 dB.

-- To determine the reference level, use an external audio measurement tool 
and set the Main Out control to generate the desired SPL level. Once Main 
Out is set, then assign a Function button to “Set Main Out to Reference 
Level”. Now, when that button is pushed, Main Out jumps to the saved 
level.

Clear Meters	 -  Clear held peak and overs from the level meters. 

Toggle Talkback	-  Turn the Talkback function on indefinitely until the button is tapped a 
second time to turn it off.

Momentary Talkback - Turn the Talkback function on only when the button is held down. 
Releasing the button turns Talkback off.

Analog Input Level - Toggle through an input’s Analog Level settings (+4 dBu, -10 dBV, Mic, 
Instrument) when that input is selected for control.

-- If the Headphone or Speaker output is selected for control and a button 
assigned to Analog Input Level is tapped, all LEDs flash for a moment to 
indicate an invalid operation.

48V Phantom Power - Toggle 48V Phantom Power on/off for the input selected for control.

Group		  - Toggle Group on/off for the input selected for control.

Soft Limit	 - Toggle Soft Limit on/off for the input selected for control.

Polarity		  - Toggle Polarity Inversion on/off for the input selected for control.

High Pass Filter	 - Toggle a 80Hz, 12dB/octave high-pass filter for the input selected for 
control.

Insert		  - Toggle insert for the input selected for control (Input 1 & 2 only).

Select Input 1..8	- Select the designated input (1-8) for control. When two interfaces are 
connected, use the Toggle Device setting to toggle between Interface A and 
Interface B.

Toggle Device	 - Toggle the interface selected for control when two interfaces are 
connected. By setting the 8 Function buttons to Select Input 1, Select Input 
2, etc and setting the Control Knob to Toggle Device, it’s possible to access 
both interfaces’ mic pre gain setting with only a few button taps.

Launch Element Control - Launch Apogee Control software or, if software is already 
launched, bring the app into keyboard focus.
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The following functions apply to the Assignable Buttons on 
Ensemble’s front panel

None	 - When a button is assigned to None, it does nothing.

Mute Speaker	 - Mute the Main speaker output.

Mute Headphones 1, 2 - Mute the Headphones output.

Mute All Outputs - Mute the Main and all Headphone outputs; tap again to unmute.

Mute Toggle Headphone/Speaker - Toggle between two states:

1.	 All Headphone outputs muted and the Main speaker output unmuted.
2.	 All Headphone outputs unmuted and the Main speaker output muted.

-- When recording in the same room as speakers, this function provides one button 
switching between recording with headphones and listening back over speakers.

Dim Speakers	 - Lower the output volume of the Main speaker output by -15dB. This function 
is convenient for briefly lowering the playback volume without completely 
muting the output.

Dim Headphone 1, 2 - Lower the output volume of the Headphones by -15dB. This function 
is convenient for briefly lowering the playback volume without completely 
muting the output.

Dim All Outputs	 - Low the output volume of the Main and Headphones -15dB. This function 
is convenient for briefly lowering the playback volume without completely 
muting the output.

Mono Speakers	 - This function is used to examine phase relationships on stereo tracks. When engaged, the left and right 
Main speaker signals are combined and phase errors between the two become more noticeable.

Mono Headphone 1, 2 - This function is used to examine phase relationships on stereo tracks. When engaged, the left and 
right Headphones signals are combined and phase errors between the two become more noticeable.

Mono All Outputs - The left and right output signals of both Main and Headphones are combined.

Engage Speaker Set A, B, C - Engage a particular speaker set when a front panel Assignable Button is pressed. Note this 
only works when the Main Output Format is set to either “2 Speaker Sets” or “3 Speaker Sets”.

Toggle Speaker Set A/B - Toggles between engaging Speaker set 1 or 2. Note this only works when the Main Output Format 
is set to either “2 Speaker Sets” or “3 Speaker Sets”.

Clear Meters	 - Removes any peak and over indicators on the level meters.

Engage Talkback - When selected, the assignable button must be held down to engage talkback.

Toggle Guitar 1 Out THRU/SW - When selected, the Assignable button will change the Guitar 1 Output source between 
THRU operation and FROM SOFTWARE operation.

Toggle Guitar 2 Out THRU/SW - When selected, the Assignable button will change the Guitar 2 Output source between 
THRU operation and FROM SOFTWARE operation.

Toggle All Guitar Outputs THRU/SW - When selected, the Assignable button will change both the Guitar 1 & 2 Output 
source between THRU operation and FROM SOFTWARE operation.



54

Apogee Ensemble Thunderbolt | User’s Guide 

Hover Help Window

For specific information about Apogee Control’s features, open the Help window and hover your Mac’s pointer 
above each setting to see a helpful summary.

Menu Bar Menus

Ensemble Control Menu

About Apogee Control - Choose this menu item to display version information 
for all hardware connected and software installed on your Mac.
Preferences > Auto Launch - Choose this menu item to launch Apogee Control 
when an Ensemble or Element Thunderbolt interface is connected to the computer.
Preferences > Keep Essentials Window On Top - Chose this menu item to prevent the Apogee Control 
Essentials window from being hidden behind other applications windows.
Hide Apogee Control - Choose this menu item to hide the Apogee Control application.
Hide Others - Choose this menu item to hide all other open applications.
Show All - If any open applications have been hidden, choose this menu 
item to reveal all open applications.
Quit Apogee Control - Choose this menu item to quit Apogee Control.
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File Menu

Open Snapshot - Choose this menu item to open a user-saved snapshot template file on your computer.
Open Snapshot Template - Choose this menu item to open the Snapshot Template Chooser window.
Save - Choose this menu item to save a user-customized Snapshot file to a location on your computer.
Save As - Choose this menu item to save a customized Snapshot file in a new name or new location on your 
computer.

View Menu

System Settings - Choose this menu item to open the System Settings sidebar.
Device Settings - Choose this menu item to open the Device Settings sidebar.
Enter Full Screen - Choose this menu item to expand Apogee Control to fill the display screen.

Window Menu

.

Selecting an item in the Window Menu 
switches to a view of that selection.

Help Menu

Use the Search Field to search for a specific menu item.
Hover Help - Opens the Hover Help Window
Element Support Online - Select this menu item to be taken to 
the Apogee website’s Support page for Element.
Ensemble Support Online - Select this menu item to be taken to 
the Apogee website’s Support page for Ensemble.
Firmware Updater - Opens the Apogee Firmware Updater app
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Apogee Control iOS App
The same features available in the Essentials Windows of the Apogee Control application are avialable in the 
Apogee Control iOS App. Here’s how it works:

1.	 Open the App Store app on your iPad, iPhone, or iPod Touch and search for 
Apogee Control.

2.	 Download and open the Apogee Control app and the “Connect to Device” 
screen will appear.

3.	 Your Apogee interface will appear in the 
“Available Interfaces” list if:

�� Your iOS device & your Mac are connected 
to the same WiFi network

�� The Apogee Driver Software has been 
installed on this Mac computer

�� The Apogee Interface is powered on and 
connected to your Mac computer

4.	 Select your Ensemble from the list of 
Available Interfaces.

5.	 A message will appear on your Mac: Click Allow.

6.	 The main Control screen will appear. It is separated into three sections:
�� Toolbar
�� Analog Input settings
�� Monitor Output settings

				       iPhone			          iPad
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iOS App Toolbar

Preferences - Opens the Preferences Menu.
Prevent Screen Lock - When engaged, the iOS device’s screen will not 
automatically turn off while the Control app is open.

Devices - Opens the Connect to Device Menu.
Clear meters - Clears any Peak Hold or Over Hold indicators on the level meters.
Talkback - Tap and hold to engage Momentary Talkback; release to disengage Momentary Talkback;
	     Double-tap to toggle Talkback on; tap again to toggle Talkback off.
Mute all outputs - Engages Mute on all speaker and headphones outputs. These mutes must be manually disengaged.

Analog Input Settings
Provides options and controls related to the analog inputs of your Apogee Thunderbolt Interface.

1.	 Input Source
-- Mic - XLR input is sent through the microphone preamp
-- Instrument - ¼” input is sent through a Hi-Z to Low-Z circuit then to the 

microphone preamp
-- +4dBu/-10dBV - Live level signal from XLR input bypasses preamp circuit

2.	 Gain - Drag your finger up or down on the gain circle to adjust the Input 
Gain.

3.	 Input Settings:

 Phantom Power: Toggles 48V phantom power on/off.

 Group: Simultaneously adjust the input gain controls of adjacent odd-even channels. Any level offsets that exist 
before inputs are grouped will be preserved after a group is chosen.

 Soft Limit: Select “On” to engage. This option begins to attenuate transient peaks at a threshold of -4dBfs.

 Polarity Invert: Use this button to invert the polarity of the input signal.

 High-Pass Filter: Use this buton to engage an 80Hz, 12dV/octave high-pass filter on the input.

 Insert: For Inputs 1 & 2 Only - Directs signal from the Insert Return jack to the A/D converter (Insert Send is always 
active and can be utilized as a preamp line-out).

4.	 Input Icon - The icon provides visual indication of the type of Input Source selected.

5.	 Input Level Meter - Shows the input signal strength after A/D conversion.
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Monitor Output Settings
Provides option and controls related to the Main and Headphones outputs of your Apogee Thunderbolt interface.

1.	 Output Source Selector - Selects the sound source for this output. The options are:
•	 Playback - Sends a playback channel stereo signal directly to this output, bypassing all mixers.
•	 Mix or FX Send - Send the stereo signal from this mixer’s Master to this output
•	 Hardware Inputs - Send an input signal directly to this output.

2.	 Output Level Control - Set the listening level of the hardware output. 

3.	 Output Mute button - Mutes the output.

4.	 Output Dim button - Reduces the output listening level by -15dB

5.	 Sum-To-Mono button - Collapse left and right signals to mono at the output. 
This combined signal is sent through both Left and Right Outputs and is useful for 
verifying the mono-compatibility of a stereo mix.

6.	 Output Icon - Indicates if the output volume is adjustable, or a fixed line-level. 

7.	 Output Level Meters - Displayed the output level. Is not affected by the output level control.

Navigation 
- Use your finger to swipe left or right to page to additional analog outputs.
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Reference

Understanding Latency
What is latency?

When recording with most computer-based digital audio applications, a delay between the input and output 
of the recording system often disturbs the timing of the musicians who are performing. This delay, known at 
latency, means that the musician hears the notes he produces a few milliseconds after having produced them. 
As anyone who has spoken on a phone call with echo knows, relatively short delays can confuse the timing of 
any conversation, spoken or musical.
 
To illustrate the effect of latency, Figure A depicts the typical signal path of a vocal overdub session. A vocalist 
sings into a microphone, which is routed through a hardware interface to the audio software application for 
recording. In the software application, the vocalist’s live signal is mixed with the playback of previously recorded 
tracks, and routed back through the hardware interface to the vocalist’s headphones. Because of the audio 
application’s latency, the vocalist hears his performance delayed by several milliseconds in his headphones.
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How does Apogee Control resolve latency?

By routing the hardware input directly to the hardware output and mixing in playback as shown in Figure B, it’s 
possible to create a headphone listening signal with a much shorter delay.

First, the signal being recorded (in this case, a vocal mic) is split in the hardware interface and routed to both the 
software application for recording and directly back to the hardware outputs without going through the latency-
inducing software; this creates a low latency path from mic to headphones. Next, a stereo mix of playback tracks 
is routed to the low latency mixer and combined with the hardware input(s). This allows the performer to hear 
both himself without a confusing delay plus the playback needed for overdubbing.

Note that the software application’s mixer is used to set a stereo mix of playback tracks while the low latency 
mixer is used to set the balance between the stereo playback mix and the hardware inputs.

Do I need the Apogee Control Mixers?

The mixers in Apogee Control serves to provide a low latency listening mix while recording. Therefore if you’re 
using Ensemble to listen to iTunes or audio from another program, there’s no need to use the mixer. 
It’s also possible that the latency of your particular recording system is low enough to be unnoticeable by you 
or other performers, especially since Ensemble uses the very efficient Thunderbolt™ 2 Technology. If you’ve set 
your audio software’s input/output buffers according to the guidelines below and latency doesn’t bother you or 
other performers, there’s no need to use the Apogee Control mixer.



61

Apogee Ensemble Thunderbolt | User’s Guide 

How do I set my software’s I/O buffer?
The I/O Buffer setting found in most audio software is one of the most crucial, but often ignored, settings in a 
Mac-based recording system.

When choosing a buffer setting, a compromise between the latency through the application and the amount of 
computer processor power accessible to the application must be made.
 
A lower Buffer setting results in lower latency but less available processing power. If the application can’t access 
enough processor power, processor overruns may occur, resulting in audible clicks and pops or error messages 
that interrupt playback and recording.
 
A higher Buffer setting, on the other hand, results in greater amount of accessible processor power (i.e. less 
chance of overruns) but increases the latency. Determining the best setting requires some trial-and-error in order 
to find the best compromise.

Keep in mind that as tracks and plug-ins are added to a software session, processor requirements increase. 
Thus, the buffer setting that works during the early stages of a session might result in processor overruns during 
later stages. 

The best strategy is to set the buffer to a lower setting during recording and accept certain limitations on plug-in 
usage, and then raise the buffer during mixing to utilize the computer’s full processor power when latency isn’t 
an issue.

With the processing power of today’s Macs, you may find that adjustment of the Buffer isn’t necessary, and you 
can leave it at a setting for low latency and still access a sufficient amount of processing power when adding 
tracks and plug-ins. If you do encounter clicks, pops or software errors, don’t hesitate to experiment with the 
Buffer setting.

Soft Limit
Soft Limit is Apogeeʼs proprietary analog process for taming transients before A/D conversion. By gently 
rounding transients in a transparent manner, itʼs possible to maximize level BEFORE the A/D conversion stage 
and prevent unwanted distortion from clipping.

When to use Soft Limit

Soft Limit is an analog process that instantaneously rounds transient peaks beginning at -4dbfs. For all intents 
and purposes attack and release times may be considered instantaneous. As with any peak reduction device 
working at such fast time constants, Soft Limit is most effective with signals whose peak information is much 
greater than its average (or RMS) information, such as drums, percussion and plucked instruments. Soft Limit 
may not be the appropriate choice for limiting signals whose crest factor (peak to RMS ratio) is low, such as bass 
or organ.
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Specifications

System Requirements
•	 Computer: Intel Thunderbolt™ Equipped Mac
•	 Memory: 4GB RAM minimum, 8GB recommended
•	 macOS 10.10 or greater
•	 Thunderbolt cable

*Thunderbolt and the Thunderbolt logo are trademarks of Intel Corporation in the U.S. and/or other countries.

The Mini DisplayPort, featured in many pre-Thunderbolt Macs, is the exact same size as the Thunderbolt port 
but does NOT support Thunderbolt devices.

X Mini DisplayPort	 √ Thunderbolt Port

For Macs equipped with a USB-C port, check the computer’s hardware specifications to ensure they are 
Thunderbolt-3 enabled. If so, then Apple’s Thunderbolt 3 to Thunderbolt 2 adapter can be used.

Thunderbolt-3 port		  Thunderbolt 3 to Thunderbolt 2 adapter

Pinout Diagram for Analog Output 3-10
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Inputs, preamps, and outputs
Analog Inputs 4 Combi mic/line/instrument inputs

- 2 1/4” balanced analog inserts
4 XLR mic/line inputs
2 1/4” hi-z guitar/instrument inputs with Class-A JFET input stage

Digital Inputs Optical IN: Supports ADAT, SMUX & S/PDIF
- ADAT: 16 channels 44.1-48 kHz on 2 Toslink connectors
- SMUX: 8 channels 88.2-96 kHz on 2 Toslink connectors
- S/PDIF: 4 channels, up to 96 kHz on 2 Toslink connectors
Coax IN: 2 channels of S/PDIF, up to 192 kHz on 1 RCA connector
Word clock input on BNC connector

Built-in Microphone Mono omnidirectional condenser capsule

Mic Preamps 8 Mic Preamps
Gain: Up to 75 dB and advanced stepped gain circuit design
Selectable 48v phantom power, hi-pass filter, Soft Limit¨ and polarity invert
EIN: 129 dB (unweighted) @ 60dB, 150 ohm input
Max Input Level: +20dBu
Input Impedance: 3k Ohm

Hi-Z Max Input Level: 14dBu
Input Impedance: >2M Ohm

Insert I/O (Balanced) max level: 20dBu

Guitar (re-amp out) (Impedance balanced) max level: 14dBu

Analog Outputs 2 1/4” balanced monitor outputs
8 balanced outputs on 1 DSUB 25-pin connector
2 independent 1/4” stereo headphone outputs
2 1/4” dual-mode guitar/instrument outputs

Digital Outputs Optical OUT: Supports ADAT, SMUX & S/PDIF
- ADAT: 16 channels 44.1-48 kHz on 2 Toslink connectors
- SMUX: 8 channels 88.2-96 kHz on 2 Toslink connectors
- S/PDIF: 4 channels, up to 96 kHz on 2 Toslink connectors
Coax OUT: 2 channels of S/PDIF, up to 192 kHz on 1 RCA connector
Word clock Output on BNC connector

Connections 2 Thunderbolt 2 ports

Max Audio Resolution 24-bit/192 kHz

A/D Conversion Max Input Level: (+4dBu ref/Mic): +20dBu
Max Input Level: (-10dBV ref): +6dBv
Input Impedance: 5kOhm
Frequency Response @ 44.1kHz sample rate 10 - 20kHz: +/- 0.2dB
Relative THD + N: -110dB
Dynamic Range: 119dB (A-weighted)

D/A Conversion Max Output Level: (+4dBu ref): +20dBu
Max Output Level: (-10dBV ref): +6dBv
Line Output Impedance: 90 Ohm
Frequency Response @44.1kHz sample rate 10-20kHz: +/- 0.05dB
Rel THD + N: -114dB
Dyn Range: 123dB (A-weighted)
Headphone max output level: 19dBu
Rel THD + N into 600 Ohm: -109dB
Dyn Range: 120dB (A-weighted)
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General
Dimensions (W x D x H) 19” X 12.125” X 1.73

Weight 11.15 lbs.

Power AC IN 100-240V, 50-60 Hz, 65W MAX

Additional Support
For more information:

•	 Apogee KnowledgeBase and FAQs
•	 Apogee Product Registration
•	 How to contact Apogee Technical Support

Visit: http://www.apogeedigital.com/support/

http://www.apogeedigital.com/support/
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Warranty Information and Legal 
Notices
Registration and Warranty Information
Be sure to register your Ensemble, either by filling in the enclosed Registration Card or by completing 
the on-line registration form at our Web site: www.apogeedigital.com/support/contact-support

If you do so, Apogee can contact you with any update information. As enhancements and upgrades are 
developed, you will be contacted at the registration address. Firmware updates are free for the first 
year of ownership unless otherwise stated.
 
Please address any inquiries to your dealer or directly to Apogee at:

APOGEE ELECTRONICS CORPORATION
1715 Berkeley St Santa Monica,CA 90404, USA
TEL: (310) 584-9394, FAX: (310) 584-9385
email: support@apogeedigital.com
web: www.apogeedigital.com/support
 
APOGEE ELECTRONICS CORPORATION warrants this product to be free of defects in material and man-
ufacture under normal use for a period of 12 months. The term of this warranty begins on the date of 
sale to the purchaser. Units returned for warranty repair to Apogee or an authorized Apogee warranty 
repair facility will be repaired or replaced at the manufacturer’s option, free of charge.
 
ALL UNITS RETURNED TO APOGEE OR AN AUTHORIZED APOGEE REPAIR FACILITY MUST BE PRE-
PAID, INSURED AND PROPERLY PACKAGED, PREFERABLY IN THEIR ORIGINAL BOX.
 
Apogee reserves the right to change or improve design at any time without prior notification. De-
sign changes are not implemented retroactively, and the incorporation of design changes into future 
units does not imply the availability of an upgrade to existing units. This warranty is void if Apogee 
determines, in its sole business judgment, the defect to be the result of abuse, neglect, alteration or 
attempted repair by unauthorized personnel. The warranties set forth above are in lieu of all other war-
ranties, expressed or implied, and Apogee specifically disclaims any and all implied warranty of mer-
chantability or of fitness for a particular purpose. The buyer acknowledges and agrees that in no event 
shall the company be held liable for any special, indirect, incidental or consequential damages, or for 
injury, loss or damage sustained by any person or property, that may result from this product failing to 
operate correctly at any time.
 
USA: Some states do not allow for the exclusion or limitation of implied warranties or liability for inci-
dental or consequential damage, so the above exclusion may not apply to you. This warranty gives you 
specific legal rights, and you may have other rights which vary from state to state. 
 
Service Information
Ensemble contains no user-serviceable components; refer to qualified service personnel for repair or 
upgrade. Your warranty will be voided if you tamper with the internal components. If you have any 
questions with regard to the above, please contact Apogee. 
In the event your Ensemble needs to be upgraded or repaired, it is necessary to contact Apogee pri-
or to shipping, and a Return Materials Authorization (RMA) number will be assigned. This number will 
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serve as a reference for you and helps facilitate and expedite the return process. Apogee requires that 
shipments be pre-paid and insured — unless otherwise authorized in advance.
IMPORTANT: ANY SHIPMENT THAT IS NOT PRE-PAID OR IS SENT WITHOUT AN RMA NUMBER WILL NOT 
BE ACCEPTED.

Warnings
FCC Warning
This equipment has been tested and found to comply with the limits for a Class A digital device, pur-
suant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against 
harmful interference when operated in a commercial environment. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruc-
tion manual, may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference, in which case the user will be required to take 
whatever measures necessary to correct the interference at his own expense.
 
Copyright Notice
Ensemble is a computer-based device, and as such contains and uses software in ROMs. This software, 
and all related documentation, including this User’s Guide contain proprietary information which is 
protected by copyright laws. All rights are reserved. No part of the software and its related documen-
tation may be copied, transferred, or modified. You may not modify, adapt, translate, lease, distribute, 
resell for profit or create derivative works based on the software and its related documentation or any 
part thereof without prior written consent from Apogee Electronics Corporation, U.S.A.
 
Software Notice
Redistribution and use in source and binary forms, with or without modification, are permitted provid-
ed that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPE-
CIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFT-
WARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Declarations of Conformity
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two condi-
tions: 

This device may not cause harmful interference
This device must accept any interference received, including interference that may cause undesired 
operation.

This equipment has been tested and found to comply with the limits of a Class B digital device, 
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pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. If this equipment does cause harmful interference 
to radio or television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures:
1.	 Re-orient or relocate the receiving antenna.
2.	 Increase the separation between the equipment and receiver.
3.	 Connect the equipment into an outlet on a different circuit from that to which the receiver is 

connected.
4.	 Consult the dealer or an experienced radio/TV technician for help.

NOTE: The use of non-shielded cable with this equipment is prohibited.
 
CAUTION: Changes or modifications not expressly approved by the manufacturer responsible for 
compliance could void the user’s authority to operate the equipment.

Apogee Electronics Corp.
1715 Berkeley Street
Santa Monica,CA 90404, USA
 
Betty Bennett, CEO.

Industry Canada Notice
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations. Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le 
matérial brouilleur du Canada.

Declaration of Conformity – CE
Apogee Electronics Corporation hereby declares that the product, the Ensemble, to which this declara-
tion relates, is in material conformity with the following standards or other normative documents:

• EN50081-1/EN55022; 1995
• EN50082-1/IEC 801-2, 3, 4; 1992
following the provisions of:
• 73/23/EEC – Low Voltage Directive
89/336/EEC – EMC Directive

Declaration of Conformity – Japan
Apogee Electronics Corporation hereby declares that Ensemble, to which this declaration relates, is in 
material conformity with the VCCI Class A standard.
 
Declaration of Conformity – Australia
Apogee Electronics Corporation hereby declares that Ensemble is in material conformity with AN/NZS 
standard requirements.
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